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CHAPTER 1

Introduction
Supported In:

With Flare, you can make your documentation accessible to people with disabilities (i.e., individuals
who have visual, hearing, and mobility impairments). Documentation is considered accessible when
it is easier for those with disabilities to use and easier to read using assistive technologies such as
Microsoft Windows Narrator, Connect Outloud, and Job Access With Speech (JAWS).

This chapter discusses the following:

Section 508 and WCAG 6

Accessibility General Considerations 7

Accessibility Features Per Output Type 8
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Section 508 and WCAG
Following are the two primary web accessibility standards:

Section 508
Section 508 In 1973 the United States government passed the Rehabilitation Act. Part of this Act is
Section 508, which was amended in 1998 and requires Federal agencies to follow standards in
developing, maintaining, acquiring, or using electronic and information technology to make
systems accessible to people with disabilities.

See https://www.section508.gov.

Web Content Accessibility Guidelines (WCAG)
Web Content Accessibility Guidelines (WCAG) These guidelines are created by the Web
Accessibility Initiative (WAI), as part of the World Wide Web Consortium (W3C), in an effort to make
the web accessible to people with disabilities.

See http://www.w3.org/WAI/intro/wcag.php.
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Accessibility General Considerations
When working to make your output accessible, consider the following:

n Different output formats in Flare support different accessibility features.

n One way to make content accessible is to provide one output for most users and an entirely
separate output for individuals with disabilities. In the locations where you have elements
that can present accessibility issues (e.g., images, multimedia), you can provide descriptions
of those elements. Then by using condition tags and different targets, you can have
customized outputs for each set of users.

n You can use character-level styles when formatting text. For example, the <strong> tag
conveys the idea that you want to emphasize the importance of some words in a paragraph.
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Accessibility Features Per Output Type
Following are accessibility features (e.g., Section 508, WCAG) supported in each output type.

HTML5 PDF Word
Clean
XHTML

Eclipse
Help EPUB

HTML
Help

Accessibility
Supported

Alt Text and
Title
Attributes

ARIA Tags

Compiler
Warnings

Empty Alt
Text for
Images

Keyboard
Navigation

Scrolling for
Toolbars and
Navigation
Frames
(Enable)

Search
Results
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HTML5 PDF Word
Clean
XHTML

Eclipse
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HTML
Help

Skip to Main
Content

User Interface
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CHAPTER 2

Accessibility and Content
There are multiple ways to adjust content to make it more accessible to end users.

This chapter discusses the following:

Alt Text and Title Attributes 11

Applying Alt Text 14

Applying Empty Alt Text to Images 21

Accessibility and Tables 23
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Alt Text and Title Attributes
Supported In:

You can accomplish much of the work of making your content accessible by setting alt and title
attributes on various elements—such as links, images, forms, and multimedia. These two attributes,
although similar, are not identical.

n Alt An alt attribute is intended to provide alternative information for elements that cannot be
seen (e.g., visually impaired individuals cannot see images in your output). The alt attribute
text should briefly describe what the element is about.

n Title A title attribute is created when you add screen tip (or tool tip) text for an element. The
title attribute text should provide additional information about the element.
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Table of Alt and Title Elements
Following are the different types of elements for which you can set alt and/or title (screen/tooltip)
attributes.

Element

Alt Attribute

(Alternate Text)

Title Attribute

(Screen Tip)

Audio (Links and Embedded)

Concept Links

Controls (e.g., Buttons, Labels, Input Boxes)

Cross-References1

Drop-Down Text

Equations

Expanding Text

Glossary Term Links

Image Hyperlinks

Image Maps

Images
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Element

Alt Attribute

(Alternate Text)

Title Attribute

(Screen Tip)

Keyword Links

Movies (Links and Embedded)

QR Codes

Related Topics Links

Table of Contents (TOC) Icons

Text Hyperlinks1

Togglers

Toolbar Items

Topic Popups

1When you add a screen tip a <title> tag is created in the markup.
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Applying Alt Text
Supported In:

Alternate "alt" text provides a textual option for non-text elements on a web page, which is required
as part of Section 508 compliance. See "Section 508 and WCAG" on page 6.

In Flare, you can apply alt text to many elements, including concept links, drop-down text,
expanding text, images, related topics, and more.
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How to Apply Alt Text Through the Language
Skin

1. Add a language skin, or open one if it is already created on your project.

2. In the upper-right corner of the skin under Language Skin Targets, select Print and Online.

3. Under the Print and Online category in your skin, scroll down to the section with the Formats.
You may need to sort the Name column to list the Formats together.

4. In the Value column, type the text of the property you wish to modify.

5. Click to save your work.
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How to Apply Alt Text Through the Stylesheet
1. Open your stylesheet.

2. In the local toolbar, make sure the first button displays . If the button displays
instead, then click it.

3. In the upper-left of the editor, make sure the drop-down field is set to
.

4. Scroll down to the section with the MadCap styles. You can modify the alt text for the
following:

n MadCap|conceptLink

n MadCap|dropDown

n MadCap|expanding

n MadCap|glossaryTerm

n MadCap|keywordLink

n MadCap|relatedTopics

n MadCap|toggler

5. From the Show drop-down list on the upper-right side of the editor, select
. The most relevant properties for that style are shown on the

right side of the editor.

6. (Optional) You can use the toggle button in the local toolbar to show properties below in a
group view or an alphabetical view .

7. If you are using the group view, expand the Unclassified group.
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8. Enter the alt text for each property. You can modify the following properties:

n mc-closed-image-alt-text

This enables alt text when the drop-down icon is closed. This property applies to the
following:

l MadCap|dropDown

l MadCap|expanding

l MadCap|glossaryTerm

l MadCap|toggler

n mc-open-image-alt-text

This enables alt text when the drop-down icon is open. This property applies to the
following:

l MadCap|dropDown

l MadCap|expanding

l MadCap|glossaryTerm

l MadCap|toggler

n mc-image-alt-text

This enables alt text on link icons. This property applies to the following:

l MadCap|conceptLink

l MadCap|keywordLink

l MadCap|relatedTopics
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EXAMPLE You want to modify the alt text for the drop-downs in your project.
So you modify the alt text when the drop-down is open, and when it is closed.

9. Click to save your work.
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Applying Alt Text and Screen Tips to All Image
References
When you insert or edit an image, you can apply alternate text or screen tips to one image at a time,
or to every instance of the image throughout the project. In Image Properties, you will see a check
box that lets you apply the same alternate text and screen tip to all image references.
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Applying Alt Text and Screen Tips to Links
When you insert or edit a link (e.g., cross-reference, or hyperlink), you can apply alternate text or
screen tips. If you open the link dialog, enter text in the appropriate field to alter its properties. See
"Accessibility and PDF Output" on page 56.

What’s Noteworthy?

NOTE If there are alt text settings for any elements in both the stylesheet and the language
skin, the stylesheet settings take precedence.
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Applying Empty Alt Text to Images
Supported In:

By default, a new image does not contain an "alt" (alternate text) attribute when you insert it into a
topic or snippet, unless you specifically add alt text in the Insert Image dialog. However, alt
attributes on images are required for Section 508 compliance, even if the string is empty or null
(alt=""). Also, by adding empty alt attributes to images, you can search the files to find the images
without alternate text and then add it as needed.

There are a couple of ways to quickly add empty alt tags to images.

How to Apply Empty Alt Text When Output is
Generated

1. Open a target.

2. On the Advanced tab of the Target Editor, select Use empty ALT text for images that do not
have ALT text.

3. Click to save your work.
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How to Apply Empty Alt Text When Images are
Inserted

1. Select File > Options. The Options dialog opens.

2. Select the XML Editor tab.

3. Select the Insert Empty Alt Text check box. A check mark indicates the feature is enabled.

4. Click OK.
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Accessibility and Tables
You can make tables more accessible by performing certain tasks. Also, support for Accessible
Rich Internet Applications (ARIA) tags helps make tables more accessible.

Accessibility Tasks
You can improve the accessibility of tables by including the following to each one:

n Header row

n Captions

n Summary
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ARIA Tags
For HTML5 output, Flare adds ARIA attributes to new tables automatically. This helps make tables
more accessible in HTML5 output by letting users know where the cursor is located in the table.

Depending on how you structure the table or table stylesheet, the following attributes will be
included in the code:

n scope="col"

l This displays when the content in a <th> tag is within a <thead> tag.

l It tells the user that the content covers the scope of the current column.
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n scope="row"

l This displays when the row content is within a header column. You can create this
scenario by changing the <td> tag in a row to a <th> tag.

l It tells the user that the content covers the scope of the current row.
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n role="rowheader"

l This displays when the content is in a column header, as specified by the Column Type
(Header) in a table stylesheet.
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l It tells the user that the content covers the scope of the current row (when it is in a <td>
tag rather than a <th> tag).

NOTE If you have already added these kinds of attributes to existing tables by using the
Internal Text Editor, Flare will not overwrite them.
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CHAPTER 3

Accessibility and the User
Interface
The user interface produced in online output is designed to improve accessibility.

This chapter discusses the following:

Accessibility and Keyboard Navigation 29

Accessibility and ARIA Tags 33

Accessibility and Skip to Main Content 38

Accessibility and Search Results 40

Accessibility and Scrolling 41

Accessibility and User Interface Text 44
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Accessibility and Keyboard Navigation
Supported In:

Flare provides the following user accessibility experience for keyboard navigation:

n Borders A border shows each element that has focus as you press TAB through them.
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n ENTER/SPACE Buttons are considered elements that trigger an activity, but do not link to
content. You can activate buttons by pressing either the ENTER or SPACE key.

n Search Elements You can tab through search fields elements, such as the input, filter, filter
drop-down, and submit button.
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n Submenus You can access submenus through the keyboard. If you press TAB on a menu
item that contains a submenu, a small drop-down arrow is temporarily shown.

If you press ENTER, the submenu is shown.
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You can then continue to press TAB to move to each item.
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Accessibility and ARIA Tags
Supported In:

Flare supports the Accessible Rich Internet Applications (ARIA) technical specification from the
World Wide Web Consortium. This is helpful for making output more accessible through screen
readers.

ARIA Accessibility Labels
For some elements, ARIA information is injected as labels in the code. You can control this label
text in a regular skin or skin component (UI Text tab) or a language skin.

EXAMPLE You are including breadcrumbs in your output. If you open the skin and select
the UI Text tab, you will see a row dedicated to the accessibility label for breadcrumbs.
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You can change the Value cell to control the text used for screen readers.
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If you build the output and look at the code, you will see navigation="role" (which indicates
the section of the page is used for navigation) and aria-label="Breadcrumbs" (which
indicates the type of navigation and the label text).
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ARIA Attributes
There are other elements where ARIA attributes are automatically added in the code.

EXAMPLE You insert a drop-down into a topic.

If you build the output and look at the code, you will see aria-expanded="true" (which
indicates the drop-down has been clicked). You will also see another attribute for ARIA
controls, as well as role="button" (which indicates that the element is a button).
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Elements Affected
The following elements can be affected by the ARIA specification:

n Breadcrumbs

n Drop-downs

n Expanding text

n Footnotes

n Glossary expanding text

n Glossary popups

n Logo

n Open Navigation button

n Popup text

n Pulse iframe

n Search button

n Side Navigation menu

n Tables (see "Accessibility and Tables" on page 23)

n Tablet and mobile menu

n Togglers

n Top Navigation menu

n Topic popups

n Topic toolbar buttons

n Tripane main structure

n Tripane navigation tabs
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Accessibility and Skip to Main Content
Supported In:

HTML5 outputs automatically include a “Skip to main content” option when users open the output
and press TAB. After encountering this option, they can press ENTER to bypass the navigation.

EXAMPLE A user who is visually impaired opens your generated output and presses the
TAB key. The user is told that she can skip to the main content.
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After pressing ENTER on the keyboard, the user’s experience is that focus moves
immediately to the topic content instead of first moving through the logo, menus, and any
other skin navigation items.
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Accessibility and Search Results
Supported In:

When you search online output, focus begins on the number of search results found. You can then
press TAB to move through each result. This helps make the results more accessible by giving you
an introduction to what follows.
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Accessibility and Scrolling
Supported In:

The Section 508 standard states, "Documents shall be organized so they are readable without
requiring an associated stylesheet." This means that some users need to view output with styles
disabled in the browser. However, if styles are disabled, the frame containing the toolbar in
WebHelp and WebHelp Plus output may not be fully visible, and no scroll bar is provided because it
was explicitly set not to display. To be in compliance with Section 508, you can use an option in a
Standard skin to set scrolling values for the toolbar and navigation frames in WebHelp and
WebHelp Plus output. See "Section 508 and WCAG" on page 6.
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How to Enable Scrolling for Toolbars and
Navigation Frames

1. Open a Standard skin.

2. Select the Styles tab.

3. In the Styles section, expand the Frame node.

4. You can select the Frame node itself or the Toolbar item.

5. Select the Property Groups or Alphabetical List option to display the properties for the style
item.
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6. In the Properties section, click in the cell to the right of Scrolling and select auto.

7. Click to save your work.

NOTE This only takes effect when stylesheets are disabled in the web browser. Please
refer to your browser for instructions on how to disable styles.
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Accessibility and User Interface Text
Supported In:

You can use the UI Text tab in the Skin Editor or a language skin to change the text for several
elements related to accessibility.

Side and Top Navigation Skins
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Tripane Skins
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CHAPTER 4

Accessibility and Analysis
Through analysis of your project and output, Flare can provide suggestions and warnings related to
accessibility. You can then adjust the project to make the necessary improvements.

This chapter discusses the following:

Viewing Accessibility Suggestions 47

Customizing Accessibility Suggestions Shown 49

Resolving Accessibility Issues 50

Accessibility and Warnings 52
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Viewing Accessibility Suggestions
Using the Accessibility Suggestions window pane, you can view places in your project where you
can make accessibility improvements for web-based and PDF outputs in Flare. This includes the
ability to identify tables that are missing certain elements and finding objects—such as images,
equations, and QR codes—that are missing alternate text. You can use the Accessibility
Suggestions Search Properties dialog to customize which types of issues to display in the window
pane.

How to View Accessibility Suggestions
1. Make sure accessibility suggestions are enabled:

a. Select File > Options.

b. Select the Project Analysis tab.

c. Ensure that Collect Accessibility Prospects is enabled.

2. Do one of the following, depending on the part of the user interface you are using:

n Ribbon Select Analysis > Suggestions > Accessibility Suggestions.

n Summary Window Pane If you have the Summary window pane in view, double-click
the row that mentions accessibility suggestions.

The Accessibility Suggestions window pane opens.

3. To see more of the information in the window pane, drag the divider bar to make the pane
wider.

n Tag Displays the tag where the issue occurs (e.g., img, table, qrCode, equation).

n Issue Displays the issue with the tag (e.g., needs alternate text, caption, summary,
header elements).

n Context Displays the context of the issue in question. For example, if the issue is that a
tag is missing alternate text, this shows the name and path of the image.

n File Displays the name of the file.

n Title Displays the properties title of the file (if any).

n Folder Displays the folder where the file is found.
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4. If a certain number of items have been found, page navigation buttons in the local toolbar
may be enabled. You can use these buttons to go to additional pages to display more items.
You can also click View All in the local toolbar to see all results on a single page. Keep in mind
that the more items you have in the project, the longer it will take to load this view.

What’s Next?
When you see issues listed in the Accessibility Suggestions window pane, you can use the Apply
Accessibility Suggestions Wizard to take action on issues that have to do with missing alternate
text. See the online Help.
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Customizing Accessibility
Suggestions Shown

You can use the Accessibility Suggestions Search Properties dialog to customize which types of
accessibility issues to look for when analyzing Flare projects. Based on your selections in this
dialog, the Accessibility Suggestions window pane updates accordingly.

How to Customize the Accessibility
Suggestions Shown in the Window Pane

1. Open the Accessibility Suggestions window pane.

2. In the local toolbar of the Accessibility Suggestions window pane, click Search Properties.
The Accessibility Suggestions Search Properties dialog opens.

3. Select any of the options in the dialog.

n Images without alt text

n Equations without alt text

n QR Codes without alt text

n Tables missing both a caption and summary

n Form elements without labels

n Frame elements missing title and name

n Tables missing header elements

n Table captions that are not the first table element

n Server-side image maps

4. Click OK.
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Resolving Accessibility Issues
When you see issues listed in the Accessibility Suggestions window pane, you can resolve them in a
couple of different ways. If the issue has to do with missing alternate text, you can use the Apply
Accessibility Suggestions Wizard to automatically add this to the elements in question; you can
also add empty alt text to multiple images at once. If the issue has to do with alternate text or
something else—such as missing captions, labels, or table header elements—you can fix the issue
manually in the user interface.

How to Resolve Accessibility Issues (Alt Text)
Automatically in a Wizard

1. Open the Accessibility Suggestions window pane.

2. In the Accessibility Suggestions window pane, select all "alt text" issues that you want to
resolve. If you want to select all rows click . You can hold the SHIFT key to select a range,
or you can hold the CTRL key to select individual items.

3. In the local toolbar, click the Apply Alt Text button.

4. A message asks if you want to apply the selected suggestions. Click OK. The Apply
Accessibility Suggestions Wizard opens.

5. Select one or more items in the list. (Select multiple items if you want the same alt text to
apply to them all.)

6. (Optional) If you selected only one item, you can click View, which opens the Media Viewer
and lets you see a preview of the object (e.g., equation, QR code, image, video). For videos
and images, file information is displayed in addition to a list of files that link to the media file.
Click OK when you are finished.

7. Click Set Text. The Change Alt Text dialog opens.

8. In the Alt Text field, you can enter the alternate text for the object (e.g., description of the
image that you want screen readers to interpret). If you want to apply empty alt text to image
(s) that you selected, leave the field blank.

9. Click OK.

10. If you are setting different alternate text for different items, repeat steps 5-9 for each item in
the wizard.
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11. Click Next. A preview of your settings is shown.

12. Click Finish.

13. Click OK.

NOTE If you want to undo the conversions, you can use the Backups window pane
(View > Backups).

How to Resolve Accessibility Issues Manually in
the Interface

1. Open the Accessibility Suggestions window pane.

2. Double-click on any file in the list to view or modify it.

3. Depending on the type of issue, use the appropriate areas of the interface to make changes:

n Image Elements You can fix the issue by editing the image and entering a description in
the Alternate Text field.

n Equation Elements You can fix the issue by editing the equation and entering a
description in the Alternate Text field.

n QR Code Elements You can fix the issue by editing the QR code and entering a
description in the Alternate Text field.

n Tables You can fix the issue by editing the table properties and entering caption text
(above the table) and/or adding a header row.

n Form Elements You can fix the issue by opening the markup for the document and
adding a label to the form. To edit the markup, you can use the Internal Text Editor or
Notepad. For more information about working with form elements (and labels within
them), see w3.org.

n Frame Elements You can fix the issue by opening the markup for the document and
adding a title to the frame element. To edit the markup, you can use the Internal Text
Editor or Notepad. For more information about working with frame elements (and
titles/names within them), see w3.org.
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Accessibility and Warnings
Supported In:

There is a Warnings tab in the Target Editor for all outputs, as well as a Build tab in the Options
dialog (File > Options) for global settings. These tabs contain check boxes that let you choose
whether to be informed when certain issues occur while building output. Some of these warnings
are related to accessibility for the following output types:

n HTML5 and WebHelp outputs

n Adobe PDF

n Eclipse Help

n Microsoft HTML Help

In other words, the accessibility warnings let you know ways that your output may not be as
accessible as it could be.
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Accessibility Warnings
The following warnings are available for Adobe PDF, Eclipse Help, Microsoft HTML Help, HTML5,
and the WebHelp outputs:

n Table has no header elements

n Table element does not contain a caption or summary

n QR code element does not contain alt text

n Equation element does not contain alt text

n Image element does not contain alt text

Web Accessibility Warnings
The following additional web accessibility warnings are available for Eclipse Help, Microsoft HTML
Help, and the WebHelp outputs:

n Frame element has no title or name

n Input element has no associated label element

n Image button element does not contain alt text

n Server-side image map entry found

n Area element does not contain alt text
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Taking Action on Warnings
If you receive one or more of these types of compiler warnings, what should you do? That depends
on the type of warning you receive:

n Image Elements If you receive this type of warning, you can fix the issue by editing the image
and entering a description in the Alternate Text field.

n Equation Elements If you receive this type of warning, you can fix the issue by editing the
equation and entering a description in the Alternate Text field.

n QR Code Elements If you receive this type of warning, you can fix the issue by editing the QR
code and entering a description in the Alternate Text field.

n Tables If you receive this type of warning, you can fix the issue by editing the table properties
and entering caption text (above the table) and/or adding a header row.

n Form Elements If you receive this type of warning, you can fix the issue by opening the
markup for the document and adding a label to the form. To edit the markup, you can use the
Internal Text Editor or Notepad. For more information about working with form elements (and
labels within them), see w3.org.

n Frame Elements If you receive this type of warning, you can fix the issue by opening the
markup for the document and adding a title to the frame element. To edit the markup, you
can use the Internal Text Editor or Notepad. For more information about working with frame
elements (and titles/names within them), see w3.org.

Ignoring Warnings
By default, all warnings (both those for accessibility and others) are enabled. However, can disable
any warnings you want, telling Flare to ignore those warnings so that they do not display as such in
the Builds window pane when generating output. This can be done globally for all targets in all
projects. You can also override those global settings for a specific target in a project.
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CHAPTER 5

Accessibility and Outputs
Keep in mind that accessibility can be treated differently, depending on the output type.

This chapter discusses the following:

Accessibility and PDF Output 56

Accessibility and Eclipse Help Output 63
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Accessibility and PDF Output
If you need your PDF to be accessible, you can build your PDF target to generate a tagged
document that is PDF/UA compliant (i.e., Portable Document Format/Universal Accessibility).

The Section 508 standard states, "In order for a PDF to be accessible, both the content and the back
end structure must be free from issues that would alter or block information to users with
disabilities.”

PDF/UA
PDF/UA is an ISO standard that enhances the readability of a document for people with disabilities.
To meet PDF/UA compliance documents must meet certain criteria regarding the tags used within
the document. A tagged PDF provides the structural representation and accessibility markup
needed for use with assistive technology devices (e.g., screen magnifiers, or screen readers). Some
users rely on these tags in PDF documents for reading and navigation.
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Optimizing PDFs for Accessibility
When generating PDFs there are some issues to look out for that might get flagged if you plan to
scan a document in an accessibility checker. See https://accessible-pdf.info/.

n All images and links must include alternate text.

n Heading levels cannot be skipped (e.g., h3 cannot follow h1).

n Proper XHTML is required for all content (e.g., a paragraph tag cannot be nested under
another paragraph tag).

n Use the document title for the title bar of the PDF output. This option is available in the Target
Editor for the PDF. In the Options tab, Initial View section, select the Title bar drop-down.

Flare handles some issues behind the scenes to meet PDF/UA compliance, but other issues can be
mitigated by what you do in Flare.

Item for
Compliance Behind the Scenes What You Can Do

PDF Tagging PDF tagging is properly structured in the
code. It fulfills PDF/UA requirements and
enables a successful scan when using an
accessibility checker.

Select the option in the Target
Editor, PDF Options tab,
Generate tagged document for
PDF/UA.

The size of the PDF output
might increase slightly.

Table
Formatting

Tables in PDF output are given a
structure that designates which cells are
header cells and which are content so
that screen readers can translate the
table data in a useful way.

Create a table that includes
header cells. You can also add a
caption or a summary attribute
for a table to make content
more accessible.

Language for
Content

When a language attribute is applied to
the project or content level, it is
automatically converted to the PDF
equivalent during compilation.

If working in a project intended
for translation, you can apply a
language attribute (e.g.,
xml:lang) to content.
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Item for
Compliance Behind the Scenes What You Can Do

Images and
Multimedia

Alternate text attributes associated with
images or multimedia are converted to
the PDF equivalent during compilation.
This enables screen readers to describe
them.

Add alternate text.

Links Alternate text attributes associated with
cross-references or hyperlinks are
converted to the PDF equivalent during
compilation.

Add alternate text to links (e.g.,
cross-references, hyperlinks).

Using an Accessibility Checker
A common tool used for determining if a PDF document is PDF/UA compliant is an accessibility
checker. There are many third-party applications available (e.g., Adobe Acrobat Pro, PAC 3) that
quickly analyze a PDF for accessibility.

NOTE Although running a PDF through an accessibility checker is good practice, relying on
it completely for accessibility is not advisable. While authoring, consider ways to make your
content more accessible from the start. You can also take advantage of the analysis tool in
Flare that reports potential accessibility issues.

NOTE Before you generate PDF output, make sure all the warnings related to accessibility
that you want to know about are set to display.
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EXAMPLE You have created a PDF document in Flare, and you want to run it through a
third-party accessibility checker to see if it is PDF/UA compliant. You decide to use the PDF
Accessibility Checker 3 (PAC 3); this program is freeware.

Locate the PDF in File Explorer.

Drag the PDF into the accessibility checker program.
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The checker runs a quick scan of the PDF and provides a summary report. It says that the
PDF is not PDF/UA compliant.
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However, this program provides some details. So, you click the Results in Detail button to
see exactly what the issue is (as shown in its Report window).

You go back into Flare, and populate the missing alternate description for the link (as
indicated in the checker).
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If you run the PDF through the checker again, it reports that the PDF/UA requirements are
fulfilled.
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Accessibility and Eclipse Help Output
Improved accessibility helps ensure that an Eclipse Help plug-in generated by Flare is as accessible
as possible to users with disabilities.

The Eclipse platform provides its own accessibility features for the Eclipse Help Viewer. To learn
more about accessibility features, visit the Workbench User Guide at http://help.eclipse.org/.
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APPENDIX

PDFs
The following PDFs are available for download from the online Help.

Tutorials
Getting Started Tutorial

Autonumbers Tutorial

Back-to-Top Button Tutorial

Context-Sensitive Help Tutorial

Custom Toolbar Tutorial

eLearning Tutorial—Basic

eLearning Tutorial—Advanced

Image Tooltips Tutorial

Lists Tutorial

Meta Tags Tutorial

Micro Content Tutorial—Basic

Micro Content Tutorial—Advanced

Responsive Output Tutorial

Single-Sourcing Tutorial

Snippet Conditions Tutorial

Styles Tutorials

Tables Tutorial

Word Import Tutorial
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Cheat Sheets
Context-Sensitive Help Cheat Sheet

Folders and Files Cheat Sheet

Learning & Development Cheat Sheet

Lists Cheat Sheet

Micro Content Cheat Sheet

Print-Based Output Cheat Sheet

Search Cheat Sheet

Shortcuts Cheat Sheet

Structure Bars Cheat Sheet

Styles Cheat Sheet

APPENDIX  65



User Guides
Accessibility Guide

Analysis and Reports Guide

Architecture Guide

Autonumbers Guide

Branding Guide

Condition Tags Guide

Context-Sensitive Help Guide

Eclipse Help Guide

eLearning Guide

Getting Started Guide

Global Project Linking Guide

HTML5 Guide

Images Guide

Import Guide

Indexing Guide

Key Features Guide

Lists Guide

MadCap Central Integration
Guide

Meta Tags Guide

Micro Content Guide

Navigation Links Guide

Plug-In API Guide

Print-Based Output Guide

Project Creation Guide

QR Codes Guide

Reviews & Contributions With
Contributor Guide

Scripting Guide

Search Guide

SharePoint Guide

Skins Guide

Snippets Guide

Source Control Guide: Git

Source Control Guide:
Perforce Helix Core

Source Control Guide:
Subversion

Source Control Guide: Team
Foundation Server

Styles Guide

Tables Guide

Tables of Contents Guide

Targets Guide

Template Pages Guide

Templates Guide

Topics Guide

Touring the Workspace Guide

Transition From FrameMaker
Guide

Translation and Localization
Guide

Variables Guide

Videos Guide

What's New Guide
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